
 

 

 
TRƯỜNG THPT HOÀNG VĂN THỤ 
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ĐỀ CƯƠNG ÔN TẬP HỌC KỲ I 

NĂM HỌC 2023- 2024 

MÔN TIN HỌC  LỚP 12 
A. LÝ THUYẾT 

I. KIẾN THỨC CƠ BẢN 

 Nắm được quy trình xử lý thông tin của một tổ chức, khái niệm CSDL và hệ quản 

trị CSDL. Các chức năng của hệ QTCSDL và vai trò của con người khi làm việc 

với CSDL. 

 Hiểu được chức năng của các đối tượng cơ bản trong Access 

 Biết cách tạo và làm việc với Bảng trong Access 

 Biết và sử dụng thành thạo các lệnh liên quan đến các thao tác: Sắp xếp, lọc, tìm 

kiếm trong bảng. 

II. KỸ NĂNG VẬN DỤNG 

 Thành thạo cách tạo và làm việc với đối tượng bảng. 

 Sử dụng thành thạo các lệnh liên quan đến các thao tác: Sắp xếp, lọc, tìm kiếm 

trong bảng. 

                       CHÚ Ý: Bỏ nội dung những phần giảm tải. 

B. BÀI TẬP 

Làm kỹ các bài thực hành trang 40, 41, 48, 49 SGK 

C. MA TRẬN ĐỀ KIỂM TRA HỌC KỲ I 

MA TRẬN ĐỀ KIỂM TRA HỌC KỲ I 

MÔN: TIN HỌC, LỚP 12 – THỜI GIAN LÀM BÀI: 45 PHÚT 

 

TT 

Nội dung 

kiến thức/ 

kỹ năng 

Đơn vị kiến thức 

Mức độ nhận thức 
Tổng 

tổng 

điểm 

Nhận 

biết 

Thông 

hiểu 

Vận 

dụng 

Vận 

dụng 

cao Số CH 
 

Số CH Số CH Số CH Số CH TN TL 

1 

Khái niệm 

CSDL và 

hệ CSDL 

1. Khái niệm cơ 

sở dữ liệu 

(CSDL) 

3 3 1 1 8   2 

2. Hệ quản trị 

CSDL 
3 3 1 1 8   2 

2 

Hệ quản 

trị CSDL 

Microsoft 

ACCESS 

1. Giới thiệu MS 

ACCESS 
3 3 1 1 8   2 

2. Cấu trúc bảng 3 3 1 1 

16   

4 

3. Các thao tác cơ 

bản trên bảng 
3 3 1 1 2 

Tổng  15 15 5 5 40   10 

 

D, MỘT SỐ CÂU HỎI MINH HỌA. 

D.1. Câu hỏi nhận biết. 

1. Các công việc thường gặp khi xử lí thông tin của một tổ chức là gì? 

2. Các công việc chính của việc khai thác hồ sơ là gì? 

3. Khái niệm cơ sở dữ liệu và hệ quản trị cơ sở dữ liệu. 

4. Các chức năng của hệ quản trị cơ sở dữ liệu là gì? 

5. Vai trò của con người khi làm việc với hệ cơ sở dữ liệu. 

6. Các bước xây dựng cơ sở dữ liệu. 

7. Khả năng của Access là gì? 

8. Các loại đối tượng chính của Access. 



 

 

9. Các chế độ làm việc với các đối tượng của Access. 

10. Các khái niệm chính trong bảng. 

11. Các tính chất của trường trong bảng. 

12. Khóa chính là gì? 

13. Cập nhật cơ sở dữ liệu gồm những thao tác gì? 

14. Định nghĩa về công cụ lọc trong cơ sở dữ liệu. 

15. Cập nhật CSDL cần thực hiện trên chế độ gì của bảng? 

D.2. Câu hỏi thông hiểu 

Câu 1: Trong Access, để tạo báo cáo theo cách dùng thuật sĩ, ta chọn ? 
A. Create table by using Wizard                B. Create query by using Wizard 

C. Create report by using Wizard              D. Create form by using Wizard 

Câu 2: Trong Access, từ nào sau đây cho phép sắp xếp dữ liệu theo chiều tăng dần? 
A. Group by             B. Criteria                C. Descending          D. Ascending 

Câu 3: Tên cột (tên trường) được viết bằng chữ hoa hay thường? 
A. Không phân biệt chữ hoa hay thường.   B. Tùy theo trường hợp 

C. Bắt buộc phải viết hoa                          D. Bắt buộc phải viết thường 

Câu 4: Để lọc dữ liệu theo ô ta chọn biểu tượng nào sau đây? 

 
Câu 5: Không thể dùng đối tượng nào để cập nhật dữ liệu? 

A. Biểu mẫu             B. Bảng                    C. Mẫu hỏi               D. Báo cáo 

Câu 6: Mỗi đối tượng của Access có các chế độ làm việc là? 
A. Chỉnh sửa và cập nhật                            B. Trang dữ liệu và thiết kế             

C. Thiết kế và bảng                                     D. Thiết kế và cập nhật 

Câu 7: Trong cửa sổ CSDL, muốn thay đổi cấu trúc 1 bảng ta chọn bảng đó rồi nháy? 

 
Câu 8: Chọn kiểu dữ liệu nào cho truờng điểm thi? 

A. Currency             B. Yes/No              C. AutoNumber         D. Number 

Câu 9: MDB viết tắt bởi 
     A. Không có câu nào đúng                         B. Manegement DataBase 

    C. Microsoft DataBase                                D. Microsoft Access DataBase 

Câu 10: Đâu là kiểu dữ liệu văn bản trong Access? 
A. Character             B. Currency                C. String                  D. Text 

Câu 11: Việc nhập dữ liệu có thể được thực hiện một cách dễ dàng thông qua? 
A. Định dạng hàng    B. Mẫu hỏi               C. Trang dữ liệu        D. Biểu mẫu 

Câu 12: Muốn sắp xếp theo thứ tự giảm dần của 1 trường, ta chọn? 
A. Dòng Sort chọn Ascending                   B. Đặt điều kiện ở dòng Criteria 

C. Dòng Sort chọn Descending                 D. Đánh dấu check vào ô show 

Câu 13: Để xóa một bản ghi ta thực hiện thao tác nào sau đây? 

A. Nháy  trên thanh công cụ rồi chọn Yes.   

B. Nháy  trên thanh công cụ rồi chọn Yes. 

C. Chọn Insert → Delete Record rồi chọn Yes     

D. Cả a và c đều đúng. 

Câu 14: Đối tượng nào sau đây được dùng để thiết kế báo cáo? 
A. Queries                B. Table                   C. Reports                D. Form 

Câu 15: Data Type có nghĩa là? 
A. Kiểu dữ liệu           B. Mô tả dữ liệu           C. Độ rộng trường        D. Tên trường 

D.3. Câu hỏi vận dụng 

1. Dữ liệu trong một CSDL được lưu trong: 



 

 

    A. Bộ nhớ RAM                                           B. Bộ nhớ ROM         

    C. Bộ nhớ ngoài                                            D. Các thiết bị vật lí 

Câu 2: Trong Acess, để mở CSDL đã lưu, thao tác thực hiện lệnh nào sau đây là đúng? 
    A. File/new/Blank Database                          B. Create table by using wizard 

   C. File/open/<tên tệp>                                   D. Create Table in Design View  

Câu 3: Việc lưu trữ dữ liệu đầy đủ và hợp lí sẽ: 
A. Hỗ trợ thống kê, báo cáo, tổng hợp số liệu.          B. Hỗ trợ ra quyết định 

C. Cả A và B đều đúng                                              D. Cả A và B đều sai. 

Câu 4: Cần tiến hành cập nhật hồ sơ học sinh của nhà trường trong các trường hợp nào sau đây? 
A. Một học sinh mới chuyển từ trường khác đến; thông tin về ngày sinh của một học sinh bị sai. 

B. Sắp xếp danh sách học sinh theo thứ tự tăng dần của tên 

C. Tìm học sinh có điểm môn toán cao nhất khối. 

D. Tính tỉ lệ học sinh trên trung bình môn Tin của từng lớp. 

Câu 5: Việc xác định cấu trúc hồ sơ được tiến hành vào thời điểm nào? 
A. Trước khi thực hiện các phép tìm kiếm, tra cứu thông tin       

B. Cùng lúc với việc nhập và cập nhật hồ sơ 

C. Sau khi đã nhập các hồ sơ vào máy tính              

D. Trước khi nhập hồ sơ vào máy tính 

Câu 6: Ngôn ngữ CSDL được sử dụng phổ biến hiện nay là: 
A. SQL                           B. Access                       C. Foxpro                       D. Java 

Câu 7: Để chỉ định khóa chính cho một bảng, sau khi chọn trường, ta thực hiện: 

A. Edit à Primary key                                B. Nháy nút  

C. A và B                                                   D. A hoặc B 

Câu 8: Trong Access, khi chỉ định khoá chính sai, muốn xóa bỏ khoá chính đã chỉ định, ta nháy 

chuột vào nút lệnh :  

 
Câu 9: Trong Access, muốn thay đổi khóa chính, ta chọn trường muốn chỉ định khóa chính rồi 

thực hiện: 

A. Nháy nút  hoặc chọn Edit → Primary Key   

B. Nháy nút  và chọn Edit → Primary Key 

C. Nháy nút                                             

D. Edit à Primary Key 

Câu 10: Trong khi làm việc với cấu trúc bảng, muốn xác định khóa chính, ta thực hiện : 

........... → Primary Key 

A. Insert                  B. Edit                  C. File                     D. Tools 

Câu 11: Trong cửa sổ CSDL, muốn thay đổi cấu trúc 1 bảng, ta chọn bảng đó rồi nháy: 

 
Câu 12: Trong khi làm việc với cấu trúc bảng, muốn xóa một trường đã chọn, ta thực hiện : 
A. Rows → Delete                              

B. Record → Delete Rows hoặc nháy nút   

C. Edit → Delete Rows hoặc nháy nút                 

D. Edit → Delete Rows hoặc nháy nút  

Câu 13: Trong khi làm việc với cấu trúc bảng, muốn chèn thêm một trường mới, ta thực hiện : 



 

 

A. Insert –> Rows                                   B. Tools –> Insert Rows       

C. Edit –> Insert Rows                            D. File –> Insert Rows 

Câu 14: Giả sử lúc tạo cấu trúc bảng thiếu một trường, để thêm một trường không phải ở vị trí 

cuối ta chọn vị trí cần thêm, sau đó nháy nút: 

 
Câu 15: Muốn xóa một bảng, ta chọn tên bảng cần xóa trong trang bảng rồi thực hiện: 
A. Nhấn phím Delete       

B. Nháy nút       

C. Edit → Delete    

D. A hoặc B hoặc C 

Câu 16: Muốn đổi bảng THISINH thành tên bảng HOCSINH ta thực hiện : 
A. Nháy chọn tên THISINH / gõ tên HOCSINH. 

B. Nháy phải chuột vào tên THISINH/ Rename / gõ tên HOCSINH. 

C. Trong chế độ thiết kế của bảng THISINH, gõ tên HOCSINH vào thuộc tính caption của trường 

chính. 

D. File / Rename / gõ tên HOCSINH 

D.4. Câu hỏi vận dụng cao 

Câu 1: Một bảng có thể có tối đa bao nhiêu trường 
A. 255                               B. 552                     C. 525                     D. Chỉ bị giới hạn bởi bộ nhớ 

Câu 2: Cho các thao tác sau: 

(1) Nháy nút  

(2) Nháy nút  

(3) Chọn ô có dữ liệu cần lọc 

Trình tự các thao tác để thực hiện được việc lọc theo ô dữ liệu đang chọn là: 
A. (3) → (1) → (2)       B. (3) → (2) → (1)              C. (3) → (1)             D. (3) → (2) 

Câu  3: Trong Access, muốn thực hiện việc hủy lọc dữ liệu, ta nháy nút : 

 
Câu 4: Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL? 
A. Người lập trình                                      B. Người dùng 

C. Người quản trị                                       D. Nguời quản trị CSDL 

Câu 5: Trong vai trò của con người khi làm việc với các hệ CSDL, người thiết kế và cấp phát 

quyền truy cập cơ sở dữ liệu, là người ? 
A. Người lập trình ứng dụng 

B. Người sử dụng (khách hàng) 

C. Người quản trị cơ sở dữ liệu        

D. Người bảo hành các thiết bị phần cứng của máy tính 

D. Câu B và C 

Câu 6: Quy trình xây dựng CSDL là: 
A. Khảo sát → Thiết kế → Kiểm thử                     B. Khảo sát → Kiểm thử → Thiết kế 

C. Thiết kế → Kiểm thử → Khảo sát                     D. Thiết kế → Khảo sát → Kiểm thử 

Câu 7: Tên của CSDL trong Access bắt buộc phải đặt trước hay sau khi tạo CSDL? 
A. Đặt tên tệp sau khi đã tạo CSDL                   

B. Vào File /Exit 

C. Vào File /Close                                              

D. Bắt buộc vào là đặt tên tệp ngay rồi mới tạo CSDL sau 



 

 

D. Memo 

Câu 8: Cửa sổ cấu trúc bảng được chia làm những phần nào? 
A. Phần định nghĩa trường và phần các tính chất của trường 

B. Tên trường (Field Name), kiểu dữ liệu (Data Type) và mô tả trường (Description) 

C. Tên trường (Field Name), kiểu dữ liệu (Data Type) và các tính chất của trường (Field Properties) 

D. Tên trường (Field Name), kiểu dữ liệu (Data Type), mô tả trường (Description) và các tính chất của 

trường (Field Properties) 

 

D. ĐỀ MINH HỌA 

TRƯỜNG THPT HOÀNG VĂN THỤ 

ĐỀ MINH HỌA 
ĐỀ KIỂM TRA KÌ I NĂM HỌC 2023 - 2024 

Môn: Tin học, Lớp 12 Thời gian 45 phút, 

Câu 1. Công việc thường gặp khi xử lí thông tin của một tổ chức là gì?    

     A. Tạo lập hồ sơ      B. Cập nhật hồ sơ 

     C. Khai thác hồ sơ      D. Tạo lập, cập nhật, khai thác hồ sơ   

Câu 2. Đâu là kiểu dữ liệu văn bản trong Access:   

     A. Character      B. String 

     C. Text      D. Currency   

Câu 3. Xét công tác quản lí hồ sơ. Trong số các công việc sau, những việc nào không thuộc nhóm thao 

tác cập nhật hồ sơ?   

     A. Xóa một hồ sơ      B. Thống kê và lập báo cáo      

     C. Thêm hai hồ sơ      D. Sửa tên trong một hồ sơ.   

Câu 4. Khi làm việc với cấu trúc bảng, để xác định tên trường, ta gõ tên trường tại cột:   

     A. File Name      B. Field Name 

     C. Name Field      D. Name   

Câu 5. Hoạt động nào sau đây có sử dụng CSDL?   

     A. Bán vé máy bay      B. Quản lý học sinh trong nhà trường      

     C. Bán hàng có quy mô      D. Tất cả đều đúng   

Câu 6. Một hệ quản trị CSDL  không  có chức năng nào trong các chức năng dưới đây?   

     A. Cung cấp môi trường tạo lập CSDL   

     B. Cung cấp môi trường cập nhật và khai thác dữ liệu   

     C. Cung cấp công cụ quản lí bộ nhớ   

     D. Cung cấp công cụ kiểm soát, điều khiển truy cập vào CSDL.   

Câu 7. Ngôn ngữ định nghĩa dữ liệu bao gồm các lệnh cho phép:   

     A. Đảm bảo tính độc lập dữ liệu   

     B. Khai báo kiểu dữ liệu, cấu trúc dữ liệu và các ràng buộc trên dữ liệu của  CSDL   

     C. Mô tả các đối tượng được lưu trữ trong CSDL   

     D. Khai báo kiểu dữ liệu của CSDL   

Câu 8. Ngôn ngữ thao tác dữ liệu thật chất là:   

     A. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật hay khai thác thông tin   

     B. Ngôn ngữ để người dùng diễn tả yêu cầu cập nhật thông tin   

     C. Ngôn ngữ SQL   

     D. Ngôn ngữ bậc cao   

Câu 9. Trong Access, muốn thay đổi khóa chính, ta chọn trường muốn chỉ định khóa chính rồi thực 

hiện:   

     A. Nháy nút    hoặc chọn Edit  Primary Key      B. Nháy nút    và chọn Edit  Primary Key   

     C. Nháy nút        D. Edit  Primary Key   

Câu 10. Hệ QT CSDL có các chương trình thực hiện những nhiệm vụ:   

     A. Phát hiện và ngăn chặn sự truy cập không được phép, tổ chức và điều khiển các truy cập đồng thời   

     B. Duy trì tính nhất quán của dữ liệu, quản lý các mô tả dữ liệu   

     C. Khôi phục CSDL khi có sự cố ở phần cứng hay phần mềm   

     D. Cả 3 đáp án A, B và C   



 

 

Câu 11. Người nào có vai trò quan trọng trong vấn đề phân quyền hạn truy cập sử dụng CSDL?   

     A. Người lập trình      B. Người dùng   

     C. Người quản trị      D. Nguời quản trị CSDL   

Câu 12. Quy trình xây dựng CSDL là:   

     A. Khảo sát  Thiết kế  Kiểm thử      B. Khảo sát  Kiểm thử  Thiết kế   

     C. Thiết kế  Kiểm thử  Khảo sát      D. Thiết kế  Khảo sát  Kiểm thử   

Câu 13. Các chức năng chính của Access?   

     A. Lập bảng      B. Tính toán và khai thác dữ liệu   

     C. Lưu trữ dữ liệu      D. Ba câu trên đều đúng   

Câu 14. Access có những khả năng nào?   

     A. Cung cấp công cụ tạo lập, lưu trữ dữ liệu      

     B. Cung cấp công cụ tạo lập, cập nhật và khai thác dữ liệu    

     C. Cung cấp công cụ tạo lập, lưu trữ và khai thác dữ liệu   

     D. Cung cấp công cụ tạo lập, lưu trữ, cập nhật và khai thác dữ liệu    

Câu 15. Các đối tượng cơ bản trong Access là:   

     A. Bảng, Macro, Biểu mẫu, Mẫu hỏi      B. Bảng, Macro, Biểu mẫu, Báo cáo   

     C. Bảng, Mẫu hỏi, Biểu mẫu, Báo cáo      D. Bảng, Macro, Môđun, Báo cáo   

Câu 16. Chọn câu  sai  trong các câu sau:   

     A. Access có khả năng cung cấp công cụ tạo lập CSDL   

     B. Access không hỗ trợ lưu trữ CSDL trên các thiết bị nhớ.   

     C. Access cho phép cập nhật dữ liệu, tạo báo cáo, thống kê, tổng hợp.   

     D. CSDL xây dựng trong Access gồm các bảng và liên kết giữa các bảng.   

Câu 17. Để khởi động Access, ta thực hiện:   

     A. Nháy đúp vào biểu tượng Access   trên màn hình nền   

     B. Nháy vào biểu tượng Access   trên màn hình nền ----> Nhấn enter   

     C. Start  All Programs  Microsoft Office  Microsoft Access   

     D. Tất cả các cách trên.   

Câu 18. Để tạo một CSDL mới và đặt tên tệp trong Access, ta phải:   

     A. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New   

     B. Vào File chọn New   

     C. Kích vào biểu  tượng New   

     D. Khởi động Access, vào File chọn New hoặc kích vào biểu tượng New, kích tiếp vào Blank 

DataBase, rồi đặt tên file và chọn vị trí lưu tệp, rồi sau đó chọn Create   

Câu 19. Muốn chèn thêm một bản ghi mới, ta thực hiện:   

     A. Insert  New Record 

     B. Nháy nút   

     C. Nháy chuột trực tiếp vào bản ghi trống ở cuối bảng rồi gõ dữ liệu tương ứng   

     D. Cả 3 đáp án trên đều đúng   

Câu 20. Có mấy chế độ chính để làm việc với các loại đối tượng?   

     A. 5 chế độ           B. 3 chế độ       C. 4 chế độ      D. 2 chế độ   

Câu 21. Để chuyển đổi qua lại giữa chế độ trang dữ liệu và chế độ thiết kế, ta nháy nút:   

     A.                   B.                                             C.    hoặc        D.  

Câu 22. Chọn kiểu dữ liệu nào cho truờng điểm “Toán”, “Lý”,...   

     A. AutoNumbe     B. Yes/No             C. Number      D. Currency   

Câu 23. Trong Access, dữ liệu kiểu ngày tháng được khai báo bằng:   

     A. Day/Type      B. Date/Type 

     C. Day/Time      D. Date/Time   

Câu 24. Hãy chọn phát biểu  đúng  trong các phát biểu sau?   

     A. Khi đã chỉ định khóa chính cho bảng, Access sẽ không cho phép nhập giá trị trùng hoặc để trống 

giá trị trong trường khóa chính   

     B. Trường khóa chính có thể nhận giá trị  trùng nhau   

     C. Trường khóa chính có thể để trống   



 

 

     D. Trường khóa chính phải là trường có kiểu dữ liệu là Number hoặc AutoNumber   

Câu 25. Cập nhật dữ liệu là:   

     A. Thay đổi dữ liệu trong các bảng   

     B. Thay đổi dữ liệu trong các bảng gồm: thêm bản ghi mới, chỉnh sửa, xóa bản ghi     

     C. Thay đổi cấu trúc của bảng   

     D. Thay đổi cách hiển thị dữ liệu trong bảng   

Câu 26. Quy trình xây dựng CSDL là: 

     A. Khảo sát -> Thiết kế -> Kiểm thử      B. Thiết kế -> Kiểm thử -> Khảo sát 

     C. Khảo sát -> Kiểm thử -> Thiết kế      D. Thiết kế -> Khảo sát -> Kiểm thử 

Câu 27. Các chức năng chính của Access 

     A. Lập bảng để lưu trữ dữ liệu, tính toán và khai thác dữ liệu                       B. Lập bảng 

     C. Tính toán và khai thác dữ liệu                                                                   D. Lưu trữ dữ liệu 

Câu 28. Chọn câu sai trong các câu sau: 

     A. Access có khả năng cung cấp công cụ tạo lập CSDL 

     B. CSDL trong Access bao gồm các bảng và liên kết giữa các bảng 

     C. Access không hỗ trợ lưu trữ CSDL trên các thiết bị nhớ. 

     D. Access cho phép cập nhật dữ liệu, tạo báo cáo, thống kê, tổng hợp. 

Câu 29. Trong Access, ta có thể sử dụng đối tượng mẫu hỏi (Query) để: 

     A. Sắp xếp, tìm kiếm và kết xuất dữ liệu từ một hay nhiều bảng 

     B. Phục hồi dữ liệu 

     C. Lưu trữ thông tin trên các thiết bị nhớ 

     D. Tạo giao diện giữa CSDL và người dùng 

Câu 30. Một hệ CSDL gồm: 

     A. 4 phần      B. 5 phần      C. 2 phần      D. 3 phần 

Câu 31: Lệnh nào sau đây dùng để lọc dữ liệu trong bảng trong Access: 

A. Filter B. Sort C. Find D. Remove Sort 

Câu 32: Lệnh nào sau đây dùng để sắp xếp tăng dần trong Access: 

A. Ascending B. Descending C. Sort D.Filter 

Câu 33: Lệnh nào sau đây dùng để sắp xếp giảm dần trong Access: 

A. Ascending B. Descending C. Sort D.Filter 

Câu 34: Lệnh nào sau đây dùng để lọc dữ liệu thỏa mãn đồng thời nhiều điều kiện: 

A. Advanced Filter by form       B.Filter       C. Filter by form Advanced                 D.Filter by form 

Câu 35: Lệnh nào sau đây dùng để tìm kiếm dữ liệu : 

A. Find B. Goto C. Select D. View 

Câu 36: Trong đối tượng bảng(table) có những thành phần nào ? 

A. Trường (field) và bản ghi (Record)          B. Field name                    C. Record         D.Data type 

Câu 37: Khi đang làm việc với đối tượng bảng ở chế độ trang dữ liệu, muốn chuyển sang chế độ thiết 

kế thì vào lệnh nào? 

A. View Design View      B.View Datasheet View           C.Design        D.Datasheet View 

Câu 38: Khi đang làm việc với đối tượng bảng ở chế độ thiết kế, muốn chuyển sang chế độ trang dữ 

liệu thì vào lệnh nào? 

A. View Datasheet View           B.View Design View       C. Design     D. Datasheet View 

Câu 39: Muốn gõ được số thập phân làm tròn đến 2 chữ số sau dấu phảy cho các trường điểm Toán, 

Văn, Anh…..thì khi thiết kế bảng, trong phần thuộc tính Decimal, ta nhập giá trị nào cho phù hợp ? 

A.  2       B. 9.9          C. 10             D. 1 

Câu 40: Một hệ quản trị CSDL không có chức năng nào trong các chức năng dưới đây? 

     A. Cung cấp công cụ quản lí bộ nhớ 

     B. Cung cấp môi trường tạo lập CSDL 

     C. Cung cấp công cụ kiểm soát, điều khiển truy cập vào CSDL. 

     D. Cung cấp môi trường cập nhật và khai thác dữ liệu 

--HẾT--- 



 

 

 

 


